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1 Introduction to PublicCMS
1.1 Profile 
PublicCMS is designed based on the latest 2023 Java technology with open source code and structure friendly to SEO. PublicCMS can operate/manage hundreds of thousands of data and PV easily. PublicCMS has been accepted and used by many famous companies and enterprises, and it owns 0.0005% of the total websites of the world. We provide free version and technical support , and we believe PublicCMS will be a good choice for great data website construction and big enterprise projects.

· PublicCMS is suitable for both dynamic website and static website;

· PublicCMS can support multi-site creation, with totally separate data and templates for each website.
1.2 License Agreement

	1. Authorized rights

1.1. Modify ,Copy and share PublicCMS and its source code;

1.2. Get free authorization document based on prerequisite agreement, and use PublicCMS in non-business conditions ( for individual user only);

1.3. Application of PublicCMS in business usage is allowed for at most 3 months. webpages developed must be marked with “Powered by PublicCMS”. The PublicCMS logo and license agreement must appear in an obvious position of the website.

1.4. Application of PublicCMS in business usage should be authorized by the owner of the software by buying the authorization document. The company authorized should be the final user of the PublicCMS.

1.5. Licensed users can Modify ,Copy and spread PublicCMS and its source code ;
1.6. The license agreement applies only to the current version of the PublicCMS, earlier versions have their own license agreement;

2. Copyright

2.1. The copyright of the software belongs to the official owner of the PublicCMS;

3. Disclaimer (of warranty)

3.1. PublicCMS and its affiliated documents are provided with no responsibilities for any possible risk, and can not provide any warranties; 

3.2. Before using PublicCMS, one should fully understand it and assume its possible risks. We won`t provide any technical support or usage warranty, and are not responsible for any risks caused by using PublicCMS unless you have bought the technology support service. 



1.3 Get PublicCMS
Executable file download:
https://www.publiccms.com/download.html
PublicCMS source code download:


GITEE: https://gitee.com/sanluan/PublicCMS

GITHUB: https://github.com/sanluan/PublicCMS
1.4 Directories
	data/publiccms

publiccms.war


· publiccms-parent is the source code of PublicCMS
· data/publiccms is the data directory of PublicCMS

sub- directories:

	indexes: Full-text search engine, automatically created by the system;

task: Script for task plan

template: Directories for templates

web: Directories for static website and resource documents


2 Fast Compiling and Running 
2.1 Compiling and Running 
Make sure that your operation system has jdk1.8 or later edition,V5 need Jdk17 or later, and execute the following command:
	cd publiccms-parent

mvnw clean package

cd publiccms/target

java -jar publiccms.war


Visit the program page http://localhost:8080/, then configure and initialize the database according to the prompts of the page.
The access route of the management background is http://localhost:8080/admin/, and the  administrator account /passwords: admin/admin are built in the data script.
2.2 Custormize Operation Mode 
· Windows start command
	java -jar -Dfile.encoding="UTF-8" -Dcms.port=8080 -Dcms.contextPath=/publiccms -Dcms.filePath="%cd%\data\publiccms" publiccms.war


· linux start command

	java -jar -Dfile.encoding="UTF-8" -Dcms.port=8080 -Dcms.contextPath=/publiccms -Dcms.filePath="`pwd`/data/publiccms" publiccms.war


· running in tomcat

Rename the “publiccms.war.original” as “publiccms.war” or” ROOT.war”( the context route is /), move the file to the tomcat webapps directory , the -Dcms.filePath parameter is still valid. 
· running in docker
execute the command：
	docker run -d -p 8080:8080 sanluan/publiccms


Mirror image warehouse：https://hub.docker.com/r/sanluan/publiccms/

· build your image
execute the command：
	docker build -t mypubliccms .

docker run -d -p 8080:8080 mypubliccms


3 Development Tools Integration
After importing PublicCMS in Development Tools, you can Compile and modify its source codes freely and do further development. 
3.1 Eclipse Maven Project Import
Eclipse Download address:  https://www.eclipse.org/downloads/
3.1.1 Procedure 
· First, choose “Import” under the File menu
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· Choose “Maven->Existing Maven Projects” in the pop-up dialog box ( import existing Maven Project)
[image: image2.png]I & import

Select
Import Existing Maven Projects

Select an import wizard:

[iype fier text

> JavaEE
v (& Maven

ing Maven Projects

& Oomph
& Plug-in Development
& Remote Systems

& Run/Debug

& SN

& Tasks

7 Check out Maven Projects from SCM

0, Install or deploy an artifact to a Maven repository
£ Materialize Maven Projects from SCM

| ® e T

Finish





· Choose ”publiccms-parent” under the pull-down menu of root directory
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· Click “ finish” to complete the import.
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3.1.2 Development Tools Configuration
Development Tools Configuration is to make it easier for you to develop PublicCMS, and keep the codes style alike.

· Character Encoding Setting 
Encoding of the project is in UTF-8 format
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· Verification Setting 
Eclipse code validation does not validate syntax such as html and freemarker mix and will report false errors. Uncheck the Validator below to help find the true error message
Client-side JavaScript

HTML Syntax Validator

JavaScript Validation

JSP Content Validator

XML Validator
[image: image6.png]8] preferences

[ype filter text
General
Ant
Cloud Foundry
Code Recommenders
Data Management
EditBox
Gradle (STS)
Gradle EniDE
Help.
HQL editor
Install/Update
Java
Java EE
Java Persistence
JavaScript
JBoss Tools
JSON
Maven
Mylyn
Oomph
Plug-in Development
Remote Systems
Run/Debug
Server
StartExplorer
Team
Terminal
Validation
Web
Web Services
XML

®®

Validation

[suspend all validators

[ save all modified resources automaticaly prier to validating

The selected validators will run when validatior

log when performing manual validations
performed:

Allow projects to override these preference setiings

Validator

Application Client (1.1) Validator
Classpath Dependency Validator

Manual

Bulld Settings

[ Client-side JavaScript
Connector (1.0,1.5) Validator
DID Validator
£18 (1:2:0) Validator
£18 3.x Validator
Enterprise Application (1) Validator
Facelet HTML Validator
HTML Syntax V
JavaScript Validation
JAXB Validator
JBoss Tools Project Validator
JPA Validator
JSF Application Configuration Valida...
JSF View Validator
JSON Validator
15P Content Validator
15P Syntax Validator

tor

IRORRRRRRNOORKRXRRXOR R

IRORRRRRROORRKRX R JORK &

IEEELEELE BElEEE B L L

Enable All

Disable All

Restore Defaults.

oK

ooy

Cancel





· Import Formative Files (optional)
Select ”Preferences” under the window menu:
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Expand the “Java->Code Style->Formatte” TAB , and click “Import” button.
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Select java.xml file. 
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Import “js.xml” to “JavaScript->Code Style->Formatter” in similar way.D
· Development Tools Plug-in (optional)
The Eclipse plug-in of FreeMarker editor is in the jboss tools.
http://download.jboss.org/jbosstools/updates/stable/ (choose the IDE version )
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Install the FreeMarker IDE plugin after keyword filter; 

Tips: FreeMarker IDE updates slow and is not very stable. It can not speed the development for techiest familiar with FreeMarker, so only beginners of FreeMarker are advised to use it.
3.2 Idea Project Import
Idea download address：https://www.jetbrains.com/idea/download/
3.2.1 Operating Steps
· First, click the Open button on the welcome page
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· Select “publiccms-parent” directory，click “OK”
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· Wait for the complete import of the idea maven plug-in. Sometimes you may need to manually select to enable maven or gradle plug-ins. 
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3.2.2 Precautions 
You need to set up the working directory first before executing any class though main method. Otherwise, startup static resources cannot be loaded or wrong file paths would appear.
Find “Edit Configurations” in “Run” menu, then modify “working directory” to the path where publiccms module resides.
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3.3 Program Configuration 
Project configuration files are under the “publiccms/src/main/resources” menu.

cms.properties are CMS configuration file.

	Configurations
	Discription
	Remarks

	cms.filePath
	Absolute path for CMS data directory
	

	cms.masterSiteIds
	Mmanagement website ID
	different ID should be separated by a half-angle comma

	cms.defaultSiteId
	Default website ID
	

	cms.tokenizerFactory
	Default Tokenizer : hmmchinese
	keyword,letter,lowercase, whitespace,edgengram, ngram, pathhierarchy, pattern, classic,standard, ax29urlemail, thai, wikipedia, hmmchinese

	cms.task.threadCount
	Task scheduling thread count
	

	cms.multipart.maxUploadSize
	Maxmium for uploaded files 
	


The cms.filePath in Configurations column can be configure by -Dcms.filePath parameter.
If there are no install.lock under the data directory or the configuration is wrong, the installment interface will be popped-up by default after visiting the program. Fill the information of the database, and choose to initialize or update data base. You can also initialize or update data base manually later.
The initialization script of the data base is under the “WEB-INF/classes/initialization/sql/”  directory; data base updating script is under the “WEB-INF/classes/initialization/upgrade/” directory;

3.4 Project Debugging 
3.4.1 Traditional Debugging 
Debugging in development tools can be done through Unit testing by writing test code or run the project in web container and debug online. Online testing is better choice for template debugging.

Choose the “Preferences” item under the Window pull-down menu, and spread to the “Server->Runtime Environments” TAB, and add a container newer than Tomcat8.0 
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Right-click on the project , select “Debug on Server” under the “Debug As” menu, or choose “Run on Server” under the “Run As” menu.
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Select the newly added container, and click “Finish” button to complete.
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Now you can debug or run the project.
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You can also select “Other” item from the “Show View” submenu in the “Window” menu.
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Click “Servers” /Open the” servers “view
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Manage the container and all the projects running or being debugged in it.
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3.4.2 SpringBoot Debugging
Find ”boot.SprintBootApplication” class in PublicCMS project, select “debug” or “run” according to your needs and execute “Main” method.
3.5 Project Release
3.5.1 Script Release
Execute the “mvn package” or “gradle war” order in “publiccms-parent” directory , generate the executable file “publiccms-parent/publiccms/target/ publiccms.war”.
3.5.2 Eclipse Project Release
· Right-click on publiccms project, then select "Export" in the pull-down menu, and select "War file" on the sub menu.
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· Select the path to Save war package and click “Finish” to complete.
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3.5.3 Eclipse Maven Project Release
· Right-click on publiccms-parent project, then select "Run As" in the pull-down menu, and select "Maven build.." on the sub menu.
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· Input clean package, and click Run
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· If compiled successfully, you can find the war package under the “target” directory of publiccms project .
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3.5.4 Eclipse Gradle Project Release
· Right- click on publiccms-parent project, and select "Run As" on the pull-down menu, then select "Gradle build.." on the sub menu.

· Input war.
· Find war file under the build directory.
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3.6 Run the Project
3.6.1 Traditional Way to Run the Project
Put “publiccms.war” under the ”webapps” directory of tomcat or the corresponding directory of other containers.
3.6.2 SpringBoot Way to Run the Project
Execute the command of “java -jar publiccms.war”
4 Secondary Development
4.1 Introduction to the Project
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4.1.1 Managment Background UI Framework Design Ideas
Management background UI interface uses dwz UI framework, the whole Management background interface is a unified page. All workspace TAB content is obtained through ajax request, and is then appended to the background page as an html fragment. Initiate the “js effect” of the appended pages. Rendering pages interactively is a much simpler process than json.
4.1.2 Project Design Ideas
PublicCMS use the following softwares and their packages: SpringMVC, Spring Boot, Hibernate, Hibernate Search, Mybatis, FreeMarker, Mysql jdbc, c3p0, jedis, jackson, quartz, Apache commons. Package dependencies, project compilation, etc., are handled by Maven and gradle.
Software requests are responded to by multiple servlets : management Servlet，front Servlet，interface Servlet，static file Servlet，install Servlet.
Management Servlet，front Servlet，interface Servlet are handled by DispatcherServlet of SpringMVC. IndexAdminController, IndexController maps the default request handling, so they have the lowest priority. The request processing logic is to directly append the page template corresponding to the request path. The page template rendering process can be extended using FreeMarker directives to obtain the required data, reducing the frequency of changes in the control layer. It realizes the maximum reuse of JAVA code in view layer . The form is processed in the traditional SpringMVC Controller receiving and processing manner.
4.1.3 Naming Convention and Project Structure
Java code：

	
.common

tools and Resolver package



.base

fudmental package



.datasource
data source package



.directive

directive
base package


.cache

cache package


.constants
Constants define packages


.handler

Paging processing, query processing, FreeMarker exception and other processor packages


.generator
code generation tool package


.search

Full-text search component package



.servlet

Servlet package



.tools

tools package



.view

view layer base package


.entities


Entity package

.logic


logic package


.component
component package



.dao


Database operation package


.service

Transaction and logical encapsulation package

.controller

controller package


.web


front website controller package


.admin

management interface controller package


.api


interface controller package

.views

    view package


.directive

freemaker user-defined directive package-freemaker


.method

freemaker user-defined method package


.pojo

Form entity package
.boot

        SpringBoot entrance package
config.spring


Spring configuration package
config.initializer

Servlet loader


Resources file ：

	resources

config



configuration file

language



language file


templates


template file




admin

management template file



ftl


auto-loaded freemarker template



web


front page templete (Lower priority to template in the data directory)


cms.properties

cms configuration files


log4j2.properties

dairy configuration files

webapp 

error


http error page( only effective when deployed in traditional web container)

META-INF



java application description files

resource



management  interface static resource files


WEB-INF



java applicationSecurity directory

index.html


prompt page for incomplete project


4.1.4 Start the Process
After starting the container, the container will load the application’s web.xml, scan The implementation class of ServletContainerInitializer, began to initialize the spring and the spring s initialize multiple initializers of PublicCMS separately and register the configuration class .
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4.1.5 Request Processing Flow
When the browser sends a request, SpringMVC first searches whether there is a Controller corresponding to request path according to request mapping rule. If yes, the Controller handles the request; If no, IndexController.page method handles the request. This method first loads the template metadata corresponding to the path to determines whether dynamic visit is allowed. If yes, the template path is returned. If no, a 404 error is returned
[image: image31.jpg]



4.1.6 Processing Template Paths
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4.2 Hibernate Entity Automatic Generation 
Use code in the project to generate
1. Configurate Database information 

Modify the total database information of configuration file: publiccms\src\test\resources\hibernate\hibernate.properties.
2. com.publiccms.common.generator. EntitysGenerator generate entity file;

3. Refresh to see the newly generated code;
4.3 Automatic Generation of Logical Code and Page
This generation method will automatically generate self-definition directive after marking the hibernate entity. Controller、Service、Dao、html are the main generation methods during the developing period of CMS.

1.  For entity property, use com.publiccms.common.generator.annotation.GeneratorColumn to mark class tag.
	Annotation properties
	Meaning

	condition
	whether used to search conditions

	order
	whether used to rank

	like
	Check whether the conditions are like matches 

	or
	Check whether the query condition is the or logic

	name
	Field name, same when or is true, field name is the same set of or conditions

	title
	True Meaning of Fields
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2.  Use com.publiccms.common.generator.SourceGenerator to generate code file;
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3.  Refresh the project to see the generated code
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4.4 Mybatis Codes Automatic Generation
1.  Modify the relative database property of “src/test/resources/generator/mybatis/generatorConfig.xml” to make sure the data base is correct and can be connected；

2.   open the files of “src/test/java/com/publiccms/common/generator/MybatisGenerator.java”

3.  Running the main function to generate Mybatis code file

4.  Refresh the project to see the generated code

4.5 Directive and Function Development
Directive is an extension of FreeMarker. Directives can either be defined in a template or implemented using java classes. In PublicCMS, the directive extension method of FreeMarker is encapsulated and extended .
Function is a FreeMarker lightweight extension that also supports template definitions and java class implementations.
These directives and functions can be invoked in templates or http requests. The parameter rules are also consistent. Implement the httpEnabled method and return false disables http and Implement the needAppToken method return true enables security authentication. Only authorized applications in ” background maintenance->application authorization” can request only through their tokens.
This section focuses on the encapsulation of java class extensions in PublicCMS. An instruction needs to inherit com.publiccms.common.base.AbstractTemplateDirective class and implements the public void execute(RenderHandler handler) throwsIOException,Exception; method; Add @Component annotation and put in an “com. Publiccms “package (can be modified through the config.spring.ApplicationConfig’s @ ComponentScan by increasing annotations or modifying the package name). You've completed the encapsulation of an instruction.
For example：
	package com.publiccms.views.directive.tools;
 

import java.io.IOException;
 

import com.publiccms.common.base.AbstractTemplateDirective;
import org.springframework.stereotype.Component;
 

import com.publiccms.common.handler.RenderHandler;
 

/**
 * 
 * MemoryDirective Technical Framework Version directive
 *
 */
@Component
public class MemoryDirective extends AbstractTemplateDirective {
 

    @Override
    public void execute(RenderHandler handler) throws IOException, Exception {
        Runtime runtime = Runtime.getRuntime();
        handler.put("freeMemory", runtime.freeMemory());
        handler.put("totalMemory", runtime.totalMemory());
        handler.put("maxMemory", runtime.maxMemory());
        handler.render();
    }
 

}


PublicCMS automatically completes the registration of directives during startup. The directive name is the class name removed of Cms, Directive character and the prefix of the last package name ; first letter in lower case; the namespace is the last package name.
Example for invoking. 

	<@tools.memory>
<p><label>total memory</label>:${totalMemory}</p>
<p><label>max memory</label>:${maxMemory}</p>
<p><label>free memory</label>:${freeMemory}</p>
</@tools.memory>
or
<p><label>total memory </label>:<span class="total"></span></p>
<p><label>max memory</label>:<span class="max"></span>}</p>
<p><label>free memory</label>:<span class="free"></span></p>
<script>
$.getJSON('//cms.publiccms.com/api/directive/memory', function(data){    
  $('.total').val(data.totalMemory);
  $('.max').val(data.maxMemory);
  $('.free').val(data.freeMemory);
});
</script>


PublicCMS encapsulates the processing of template directive data aliases and the use of aliases：

	<@tools.memory;total,max,free>
<p><label>total memory</label>:${total}</p>
<p><label>max memory</label>:${max}</p>
<p><label>free memory</label>:${free}</p>
</@tools.memory>


The encapsulation of PublicCMS also completed the recovery of template variables. Therefore, these variables could not be obtained after the instruction, which could be simply understood as the closure principle. If the same variable exists in the previous article, this variable will also be reducted. For example:
	<!-- There is no “object” variable -->
<@cms.category id=1> <!-- The “category” directive queries classified entities based on the input parameter “id” and exports the result as “object” -->
    <!-- The “object” variable represents the classified entity with “id” 1 -->
    <@cms.content id=1>  <!-- The “content” directive queries classified entities based on the input parameter “id” and exports the result as “object” -->
        <!-- The “object” variable represents the classified entity with “id” 1 -->
    </@cms.content>
    <!-- The “object” variable represents the classified entity with “id” 1 -->
</@cms.category>
<!-- There is no “object” variable -->


RenderHandler is an operation that encapsulates the input and output parameters of an instruction. See the source code or api documentation for more apis.

handler.getLong("id")，You get an input parameter id of type long；

handler.put("object", entity)，Variables can be exported;

handler.render()，You can render the contents of the template contained in the directive. If a directive does not excute render(), the templates contained in the directive will not be rendered. A common usage scenario：

	<@cms.content id=-1> contents here will not be output and executed </@cms.content>


An instruction needs to inherit com.publiccms.common.base.BaseMethod class and implements public Object exec(@SuppressWarnings("rawtypes") List arguments) throws TemplateModelException method; Add @Component annotation and put in an “com. Publiccms “ package.
Functions can take multiple arguments and are placed in arguments. BaseMethod encapsulates the value methods for common argument types. After processing the data, you can return them directly. For example  ：

	package com.publiccms.views.method.tools;
 

import java.util.List;
 

import org.springframework.stereotype.Component;
 

import com.publiccms.common.base.BaseMethod;
import com.publiccms.common.tools.CommonUtils;
import com.publiccms.common.tools.VerificationUtils;
 

import freemarker.template.TemplateModelException;
 

/**
 *
 * GetMd5Method
 * 
 */
@Component
public class GetMd5Method extends BaseMethod {
 

    @SuppressWarnings("unchecked")
    @Override
    public Object exec(@SuppressWarnings("rawtypes") List arguments) throws TemplateModelException {
        String string = getString(0, arguments);
        if (CommonUtils.notEmpty(string)) {
            return VerificationUtils.md5Encode(string);
        }
        return null;
    }
     

    @Override
    public boolean needAppToken() {
        return false;
    }
 

    @Override
    public int minParametersNumber() {
        return 1;
    }
}


PublicCMS automatically completes the registration of function during startup. The function name is the class name removed of Method character; first letter in lower case; 

Example for invoking. 
	${getMd5("string")!}


4.6 Development of data export function 
PublicCMS does a implified encapsulation to excel’s export function. The returning of the view name to com.publiccms.common.view.ExcelView can complete the rendering of excel file. This construction method has two parameters, the file name and consumers. The consumer is used to construct the data body, and the file name can also be passed in a subsequent method. If there is no file name, the request path export may be taken as the file name
	@RequestMapping("export")
public ExcelView export() {
    ExcelView view = new ExcelView(workbook -> {
        Sheet sheet = workbook.createSheet("sheetname");
        int i = 0, j = 0;
        Row row = sheet.createRow(i++);
        row.createCell(j++).setCellValue("id");
        row.createCell(j++).setCellValue("title");
        row = sheet.createRow(i++);
        row.createCell(j++).setCellValue("id");
        row.createCell(j++).setCellValue("title");
    });
    view.setFilename("filename");
    return view;
}


In the actual development, we need to query the data body according to the request parameters, and the excel header and file name need to be internationalized. For example:
	package com.publiccms.controller.admin.cms;
 

import java.io.Serializable;
import java.text.DateFormat;
import java.util.ArrayList;
import java.util.Date;
import java.util.HashMap;
import java.util.List;
import java.util.Locale;
import java.util.Map;
 

import javax.servlet.http.HttpServletRequest;
 

import org.apache.commons.logging.Log;
import org.apache.commons.logging.LogFactory;
import org.apache.poi.ss.usermodel.Row;
import org.apache.poi.ss.usermodel.Sheet;
import org.springframework.beans.factory.annotation.Autowired;
import org.springframework.format.annotation.DateTimeFormat;
import org.springframework.stereotype.Controller;
import org.springframework.ui.ModelMap;
import org.springframework.web.bind.annotation.RequestAttribute;
import org.springframework.web.bind.annotation.RequestMapping;
import org.springframework.web.servlet.support.RequestContextUtils;
 

import com.publiccms.common.annotation.Csrf;
import com.publiccms.common.constants.CommonConstants;
import com.publiccms.common.handler.PageHandler;
import com.publiccms.common.tools.CommonUtils;
import com.publiccms.common.tools.DateFormatUtils;
import com.publiccms.common.tools.ExtendUtils;
import com.publiccms.common.tools.LanguagesUtils;
import com.publiccms.common.view.ExcelView;
import com.publiccms.entities.cms.CmsPlace;
import com.publiccms.entities.cms.CmsPlaceAttribute;
import com.publiccms.entities.sys.SysExtendField;
import com.publiccms.entities.sys.SysSite;
import com.publiccms.entities.sys.SysUser;
import com.publiccms.logic.component.site.SiteComponent;
import com.publiccms.logic.component.template.MetadataComponent;
import com.publiccms.logic.component.template.TemplateComponent;
import com.publiccms.logic.service.cms.CmsPlaceAttributeService;
import com.publiccms.logic.service.cms.CmsPlaceService;
import com.publiccms.logic.service.log.LogOperateService;
import com.publiccms.logic.service.sys.SysUserService;
import com.publiccms.views.pojo.entities.CmsPlaceMetadata;
 

/**
 * 
 * cmsPlaceController
 *
 */
@Controller
@RequestMapping("cmsPlace")
public class CmsPlaceAdminController {
    protected final Log log = LogFactory.getLog(getClass());
    @Autowired
    private CmsPlaceService service;
    @Autowired
    private CmsPlaceAttributeService attributeService;
    @Autowired
    private SysUserService sysUserService;
    @Autowired
    private MetadataComponent metadataComponent;
    @Autowired
    protected LogOperateService logOperateService;
    @Autowired
    protected SiteComponent siteComponent;
 

    /**
     * @param site
     * @param path
     * @param userId
     * @param status
     * @param itemType
     * @param itemId
     * @param startPublishDate
     * @param endPublishDate
     * @param orderField
     * @param orderType
     * @param request
     * @param model
     * @return view name
     */
    @RequestMapping("export")
    // csrf validation
    @Csrf
    // Automatic assembly of date fields requires declaration of the format
    public ExcelView export(@RequestAttribute SysSite site, String path, Long userId, Integer[] status, String itemType,
            Long itemId, @DateTimeFormat(pattern = "yyyy-MM-dd") Date startPublishDate,
            @DateTimeFormat(pattern = "yyyy-MM-dd") Date endPublishDate, String orderField, String orderType,
            HttpServletRequest request, ModelMap model) {
        if (CommonUtils.notEmpty(path)) {
            path = path.replace("//", CommonConstants.SEPARATOR);
        }
        // Get internationalization information from the request, or based on user, site Settings, and so on
        Locale locale = RequestContextUtils.getLocale(request);
 

        String filePath = siteComponent.getWebTemplateFilePath(site, TemplateComponent.INCLUDE_DIRECTORY + path);
        CmsPlaceMetadata metadata = metadataComponent.getPlaceMetadata(filePath);
         

        // Data query
        PageHandler page = service.getPage(site.getId(), userId, path, itemType, itemId, startPublishDate, endPublishDate,
                CommonUtils.getMinuteDate(), status, false, orderField, orderType, 1, PageHandler.MAX_PAGE_SIZE);
        @SuppressWarnings("unchecked")
        List<CmsPlace> entityList = (List<CmsPlace>) page.getList();
         

        // Related data primary key assembly
        Map<String, List<Serializable>> pksMap = new HashMap<>();
        for (CmsPlace entity : entityList) {
            List<Serializable> userIds = pksMap.computeIfAbsent("userIds", k -> new ArrayList<>());
            List<Serializable> ids = pksMap.computeIfAbsent("ids", k -> new ArrayList<>());
            userIds.add(entity.getUserId());
            userIds.add(entity.getCheckUserId());
            ids.add(entity.getId());
        }
        // Related data query and assembly, reduce the database query times
        Map<Serializable, SysUser> userMap = new HashMap<>();
                Map<Serializable, CmsPlaceAttribute> attributeMap = new HashMap<>();
        if (null != pksMap.get("userIds")) {
            List<Serializable> userIds = pksMap.get("userIds");
            List<SysUser> entitys = sysUserService.getEntitys(userIds.toArray(new Serializable[userIds.size()]));
            for (SysUser entity : entitys) {
                userMap.put(entity.getId(), entity);
            }
            List<Serializable> ids = pksMap.get("ids");
                        List<CmsPlaceAttribute> attributes = attributeService.getEntitys(ids.toArray(new Serializable[ids.size()]));
                        for (CmsPlaceAttribute attribute : attributes) {
                            attributeMap.put(attribute.getPlaceId(), attribute);
                        }
        }
 

        ExcelView view = new ExcelView(workbook -> {
            Sheet sheet = workbook
                    .createSheet(LanguagesUtils.getMessage(CommonConstants.applicationContext, locale, "page.content"));
            int i = 0, j = 0;
            // Create a header row and add a field
            Row row = sheet.createRow(i++);
 

            row.createCell(j++).setCellValue(LanguagesUtils.getMessage(CommonConstants.applicationContext, locale, "page.id"));
            row.createCell(j++).setCellValue(LanguagesUtils.getMessage(CommonConstants.applicationContext, locale, "page.title"));
            row.createCell(j++).setCellValue(LanguagesUtils.getMessage(CommonConstants.applicationContext, locale, "page.url"));
            row.createCell(j++).setCellValue(
                    LanguagesUtils.getMessage(CommonConstants.applicationContext, locale, "page.content.promulgator"));
            row.createCell(j++)
                    .setCellValue(LanguagesUtils.getMessage(CommonConstants.applicationContext, locale, "page.clicks"));
            row.createCell(j++)
                    .setCellValue(LanguagesUtils.getMessage(CommonConstants.applicationContext, locale, "page.publish_date"));
            row.createCell(j++)
                    .setCellValue(LanguagesUtils.getMessage(CommonConstants.applicationContext, locale, "page.create_date"));
            row.createCell(j++)
                    .setCellValue(LanguagesUtils.getMessage(CommonConstants.applicationContext, locale, "page.status"));
            row.createCell(j++)
                    .setCellValue(LanguagesUtils.getMessage(CommonConstants.applicationContext, locale, "page.inspector"));
            // Add a field column for extended data
            if (CommonUtils.notEmpty(metadata.getExtendList())) {
                for (SysExtendField extend : metadata.getExtendList()) {
                    row.createCell(j++).setCellValue(extend.getName());
                }
            }
 

            SysUser user;
            CmsPlaceAttribute attribute;
            DateFormat dateFormat = DateFormatUtils.getDateFormat(DateFormatUtils.FULL_DATE_FORMAT_STRING);
            // Data is traversed and written line by line
            for (CmsPlace entity : entityList) {
                row = sheet.createRow(i++);
                j = 0;
                row.createCell(j++).setCellValue(entity.getId().toString());
                row.createCell(j++).setCellValue(entity.getTitle());
                row.createCell(j++).setCellValue(entity.getUrl());
                user = userMap.get(entity.getUserId());
                row.createCell(j++).setCellValue(null == user ? null : user.getNickName());
                row.createCell(j++).setCellValue(String.valueOf(entity.getClicks()));
                row.createCell(j++).setCellValue(dateFormat.format(entity.getPublishDate()));
                row.createCell(j++).setCellValue(dateFormat.format(entity.getCreateDate()));
                 

                row.createCell(j++).setCellValue(LanguagesUtils.getMessage(CommonConstants.applicationContext, locale,
                        "page.status.place.data." + entity.getStatus()));
 

                // Related data unpacking and use
                user = userMap.get(entity.getCheckUserId());
                row.createCell(j++).setCellValue(null == user ? null : user.getNickName());
                 

                // Extended data traversal writes
                if (CommonUtils.notEmpty(metadata.getExtendList())) {
                    attribute = attributeMap.get(entity.getId());
                    Map<String, String> map = ExtendUtils.getExtendMap(null == attribute ? null : attribute.getData());
                    for (SysExtendField extend : metadata.getExtendList()) {
                        row.createCell(j++).setCellValue(map.get(extend.getId().getCode()));
                    }
                }
            }
        });
        DateFormat dateFormat = DateFormatUtils.getDateFormat(DateFormatUtils.SHORT_DATE_FORMAT_STRING);
        // setting the file name
        view.setFilename(metadataComponent.getPlaceMetadata(filepath).getAlias()+"_"+dateFormat.format(new Date()));
        return view;
    }
 

}


5 Technical support
5.1 Free Technical Support
PublicCMS official website：https://www.publiccms.com/
QQ communication group：191381542 , 481589563 , 638756883
Freemarker files：http://www.kerneler.com/freemarker2.3.23/
Online debuggingFreeMarker：https://www.sanluan.com/freemarker_test.html
5.2 Commercial Technical Support
You can get commercial technical support after buying the software usage authorization, and you can also buy the commercial technical support service alone.
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